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FAILURE OR IMPROPER SELECTION OR IMPROPER USE OF THE PRODUCTS DESCRIBED 
HEREIN OR RELATED ITEMS CAN CAUSE DEATH, PERSONAL INJURY AND PROPERTY 
DAMAGE.

This document and other information from Parker-Hannifin Corporation, its subsidiaries and 
authorized distributors provide product or system options for further investigation by users having 
technical expertise.

The user, through its own analysis and testing, is solely responsible for making the final selection 
of the system and components and assuring that all performance, endurance, maintenance, 
safety and warning requirements of the application are met. The user must analyze all aspects 
of the application, follow applicable industry standards, and follow the information concerning 
the product in the current product catalog and in any other materials provided from Parker or its 
subsidiaries or authorized distributors.

To the extent that Parker or its subsidiaries or authorized distributors provide component or 
system options based upon data or specifications provided by the user, the user is responsible for 
determining that such data and specifications are suitable and sufficient for all applications and 
reasonably foreseeable uses of the components or systems.

WARNING — USER RESPONSIBILITY
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1. Introduction

Ordering code D*FB

Nominal
size

Direct. 
control 
valve

Spool-
type
(see 

catalogue)

Command-
signal

Seal
NBR

(different seal 
compound by 

request)

Option

D NF B 0

Code Nominal size

1 NG06 / CETOP 3

3 NG10 / CETOP 5

Code Spool position

C

E

K

Code
Command 

signal
Function Connection 2) Option

F0 0...+/-10 V 0...+10 V > P-A 6 + PE Pot.-supply

G0 0...+/-20 mA 0...+20 mA > P-A 6 + PE –

S0 4...20 mA 12...20 mA > P-A 6 + PE –

W5 1) 0...+/-10 V
4...20 mA

0...+10 V > P-A
12...20 mA > P-A

11 + PE
Pot.-supply & 

command preset 
channel

D*FB

Spool 
position

Code Design

0
Spool/sleeve 

design

3
Spool/body 

design

Design

1) Factory set +/-10 V
2) Please order female connector separately.

Design
series

(not 
required 

for 
ordering)

Parametrizing connection

Main connector 
(always on B-side)

Manual
override
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Ordering code D*1FB

D

Direct. 
control 
valve

Spool 
type
(see 

catalogue)

Spool 
position

Proportional 
control

NG06
pilot 2)

Command 
signal

1 B

Seal

Flow
(see 

catalogue)

Pilot 
connection

F C

Nominal
size

Valve 
accessories

Option

Code
Valve 

accessories

0 Standard

8 Monitor switch

Code
Command 

signal
Function Connection 3) Option

F0 0...±10 V 0...+10 V > P-B 6 + PE Pot.-supply

M0 0...±10 V 0...+10 V > P-A 6 + PE Pot.-supply

S0 4...20 mA 12...20 mA > P-A 6 + PE —

G0 0...±20 mA 0...+20 mA > P-B 6 + PE —

W5
0...±10 V
4...20 mA

0...+10 V > P-A
12...20 mA > P-A

11 + PE

Pot.-supply 
& command 

preset 
channels

Code Nominal size

3 NG10 / CETOP05

4 NG16 / CETOP07

9 1) NG25 / CETOP08

11 NG32 / CETOP10

Code Inlet Drain

1 internal external

2 external external

4 internal internal

5 external internal

1)  With enlarged connections Ø 32 mm
2) As D1FV* separately available
3) Please order female connector separately.

Design
series

(not 
required 

for 
ordering)

Code Seal

N NBR

V FPM
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Parker D*FB/D*1FB proportional directional control 
valves have an integral electronic and requires only 
one sole electrical common for the control system. 
Different flow sizes, as well as command signal op-
tions are available to achieve an optimal adaption 
for different applications.

Characteristics of Valve Driver 

The described integral electronic driver combines 
all necessary functions for the optimal operation of 
the valve. The most important features are: 

• digital circuit design
• high dynamic constant current solenoid control 
• differential input stage with various command 

signal options
• four quadrant ramp function
• MIN adjustment for deadband compensation
• MAX adjustment to match the command signal 

span to the valve operating range
• optional reference outputs +/- 10 V for potentio-

meter supply
• optional four parametrizable preset recall chan-

nels
• standard central connection
• compatible to the relevant European EMC-

standards
• comfortable interface program

Name Plate Example Block Diagram of Integral Electronics
Code F0/M0 (6+PE)

Code S0/G0 (6+PE)

Code W5 (11+PE)
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Technical Data

General
Model Proportional directional control valve, direct operated (D*FB), 

pilot operated (D*1FB)
Drive Proportional solenoid
Mounting Pattern NG6 (CETOP 3) / NG10 (CETOP 5) 

NG16 (CETOP 7) / NG25 (CETOP 8) / NG32 (CETOP 11)
Installation Position Any
Hysteresis D1FB*0/D3FB*0 [%] < 4
  D3FB*3/D*1FB [%] < 5
Ambient Temperature Range [°C] -20...+60
MTTFD value [years] 150 (D*FB), 75 (D*1FB)
Protection Class NEMA 4 (IP 65) acc. EN 60529
Weight [kg] NG6: 3 / NG10: 7 / NG16: 11 / NG25: 19.5 / NG32: 61
Vibration Strength [g] 10 Sinus 5...2000 Hz acc. IEC 68-2-6

10 (RMS) Random noise 20...2000 Hz acc. IEC 68-2-36
15 Shock acc. IEC 68-2-27

Hydraulic
Operating Pressure max. (D*FB)
 Pilot oil intern (D*1FB):
 Pilot oil extern (D*1FB):

[bar]
[bar]
[bar]

350 for ports P, A, B  /  210 for port T
350 for ports P, A, B, X / 185 for T, Y
350 for ports P, A, B, T, X / 185 for Y

Fluid Hydraulic oil according to DIN 51524...535, other on request
Fluid Temperature [°C] -20...+60 (NBR: -25...+60)
Viscosity permitted [cSt]/[mm2/s] 20...400
Filtration ISO 4406; 18/16/13
Electrical
Duty Ratio [%] 100
Supply Voltage Us [VDC] 18...30, ripple <5% eff., surge free
Current Consumption max. [A] D1FB: 2.0 / D3FB: 3.5 / D*1FB: 2.0
Pre-Fusing [A] D1FB: 2.5 / D3FB: 4.0 / D*1FB: 2.5
Potentiometer supply Up [V] ± 10 / ± 5 % max. 10 mA
Command Signal Options Uc
  
 Ic

[V] 

[mA]

[mA]

Codes F0, M0, W5: +10...0...-10, ripple <0.01 % eff., surge free,  
Ri = 100 kOhm
Codes S0 & W5: 4...12...20, ripple <0.01 % eff., surge free,  
Ri = <250 Ohm
< 3.6 mA = enable off, > 3.8 mA = enable on (acc. NAMUR NE43)
Code G0: +20...0...-20, ripple <0.01 % eff., surge free,  
Ri = <250 Ohm

Differential Input Voltage max. [V] Codes F0, M0, S0, G0: 30 for terminal D and E against PE (terminal G)
[V] 11 for terminal D and E against 0 V (terminal B)
[V] Code W5: 30 for terminal 4 and 5 against PE (terminal W)
[V] 11 for terminal 4 and 5 against 0 V (terminal 2)

Channel Recall Signal Uch [V] 0...2.5: Off / 5...30: On / Ri = 100 kOhm
Adjustment Ranges Min [%] 0...50
 Max [%] 50...100
 Ramp [s] 0...32.5
Interface RS 232C, parametrizing connection 5pole
EMC EN 61000-6-2, EN 61000-6-4
Central Connection Codes F0, M0, S0, G0:  6 + PE acc. EN 175201-804

Code W5: 11 + PE acc. EN 175201-804
Cable Specification [mm²] Codes F0, M0, S0, G0: 7 x 1.0 (AWG16) overall braid shield

[mm²] Code W5: 11 x 1.0 (AWG16) overall braid shield
Cable Length max. [m] 50



8

Prop. Directional Control Valve
Series D*FB / D*1FBOperation Manual

Parker Hannifin CorporationParker Hannifin Corporation

D_FB-D_1FB_10-12 5715-669 UK.indd 25.06.19

Signal flow diagram
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Scope of supply

Please check immediately after receiving the valve, 
if the content is matching with the specified scope 
of supply. The delivery includes:

• valve

• operation manual

The central connector assembly has to be ordered 
separately and is not included in the delivery. 

 Please check the delivery immediately after 
receiving the shipment for apparent damag-
es due to shipping. Report shipment losses 
at once to the carrier, the insurance compa-
ny and the supplier!

Intended usage

This operation manual is valid for proportional di-
rectional control valves D*FB/D*1FB series. Any dif-
ferent or beyond it usage is deemed to be as not 
intended. The manufacturer is not liable for warran-
ty claims resulting from this.

Information on the process of technical changes

We reserve the right to make technical changes as 
a result of further development of the product de-
scribed in these operating instructions. Figures and 
drawings in these instructions are simplified depic-
tions. As a result of developments, improvements 
and changes to the product, it is possible that the 
figures are not fully consistent with the valve in op-
eration. The technical details and dimensions are 
non-binding. They may not form the basis of any 
claims. Copyright reserved.

Information on warranty and liability

The manufacturer does not assume liability for dam-
age due to the following failures:

• incorrect mounting / installation

• improper handling

• lack of maintenance

• operation outside the specification

 Do not disassemble the valve! In case of sus-
picion for a defect please return it to Parker.

CE mark

The CE mark appears on the main nameplate. If 
the product is installed as part of a larger machine, 
this larger machine is in turn subject to EU direc-
tives and must therefore obtain a general CE mark 
for the machine as a whole. The machine must not 
enter circulation in the EU until this is done. The 
legal requirements corresponding to the CE mark 
can be found in section "Other applicable stan-
dards / rules".

Personnel requirements

The product may only be used, installed, removed, 
operated and maintained by specialist personnel. 
For the purposes of these instructions, a specialist 
is defined as someone who, on the basis of their 
education, expertise and professional experience, 
is able to correctly evaluate and carry out the tasks 
and duties assigned to him/her, and identify and 
correct potential hazards. Skilled, semi-skilled or 
trained personnel may not use this product under 
their own responsibility unless they have the re-
quired specialist knowledge. Otherwise, they may 
only use the product under the constant supervi-
sion of a specialist person.

Compliance with other rules and instructions

Carry out transport and installation/repair activi-
ties only in accordance with the valid and applica-
ble safety and accident prevention regulations is-
sued by the trade associations.

The valve contains hydraulic oil. The normal local 
environmental protection requirements must there-
fore be met when handling the product. The par-
ticular circumstances of each place of installation 
mean that instructions must be followed in order 
to install and use the product safely.

2. Safety

Safety instructions

Please read the operation manual before installa-
tion, startup, service, repair or stocking! Paying no 
attention may result in damaging the valve or in-
corporated system parts.
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Use of the product

The product must only be used if it is perfect in 
working order. Problems that may impair safety 
must be corrected.

 This product is a safety component that may 
only be repaired by the manufacturer if it mal-
functions. If the safety components are re-
paired by the user, the manufacturer's war-
ranty is  inval idated because the 
manufacturer is demonstrably unable to en-
sure that the product is used as specified. 

Limits of use

The product may only be operated within the spec-
ified limits of use. The relevant details can be found 
in „Technical data“.

 Ambient conditions must be observed. Un-
authorized temperatures, shocks, the effects 
of aggressive chemicals, radiation, unauthor-
ized electromagnetic emissions may result in 
disruptions and failures. Observe the limits 
of operation set out in „Technical data”. 

Contaminations

Function and service life of the valve are heavi-
ly dependent on the purity and quality of the pres-
sure fluid and depend upon the operating condi-
tions of the hydraulic components. Appropriate filters 
must be used and regular inspections of the medi-
um must be carried out to prevent contamination 
of the pressure fluid. Permitted level of contamina-
tion is set out in the „Technical data“.

Be aware of three important sources of con-
tamination:

• Contaminations entering during installation

• Contaminations occurring during operation

• Dirt entering from the surroundings

Remaining risks

Allergic reactions

Hydraulic oil can cause allergic reactions on sus-
ceptible skin. This can be prevented by taking the 
precautions that are usual when handling miner-
al oil products and by using personal protective 
equipment.

Leaking plugs

 Leaking plugs can cause a malfunction. That 
is why the plugs must be checked for leaks 
at the regular maintenance interval. Leaking 
plugs may constitute a safety hazard, so the 
valve must be returned to Parker for repair.

Lightning

 If electronic components are exposed to elec-
tromagnetic fields as a result of lightning, they 
must be checked to ensure they are still work-
ing perfectly. If there is a malfunction, the 
product must be returned to Parker.

Temperature

The surface of our product may heat up in use.

 The service temperatures may exceed the 
temperature threshold for burn injury, 70 °C. 
Above this threshold, even brief contact with 
the surface may result in a burn. The only way 
to consistently prevent burn injuries is to use 
personal protective equipment and to remain 
safety-conscious at all times. 

 If integrated electronics are exposed to a tem-
perature above 80 °C, they may malfunction.

Power failure

 In a power failure the valve piston returns to 
the spring centred starting position. You must 
check whether this creates potential hazards 
when the system/machine is used. 

Hydraulic

D*FB/D*1FB valves are tested and approved with 
an even flow. If the flow becomes asymmetrical, 
the safety function of the valve may be compro-
mised. You should therefore carry out tests before 
commissioning to verify that the valve is in good 
working order. 

If the valve piston has been under pressure and 
stationary in the end position for an extended pe-
riod, oil particles may cause the piston to seize. For 
this reason the valve should be actuated regularly.
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Storage time Conditions

12 months
Stable air humidity 60 % and sta-
ble temperature < 25 °C 

6 months
Fluctuating air humidity and fluctu-
ating temperature < 35 °C 

3. Use of the product

Transport

Depending on size, lifting equipment or transport 
aids are needed. Our product leaves the factory in 
perfect working order, and appropriate packaging 
is used to protect it from damage. 

 The condition of the product on arrival is no 
longer under our control, so please check for 
transport damage/defects immediately after 
arrival. Document the transport damage and 
immediately notify the carrier, the insurance 
company and the manufacturer. Do not dis-
pose of the packaging unless there is no trans-
port damage and the entire package contents 
have been removed from the packaging. If 
the product has been damaged during trans-
port, it must be exchanged for a new one.

When transporting the product within your premis-
es, make sure it is kept in a safe position and pro-
tected in its original packaging until it is ready to 
use. Note also the information in sections “Warranty 
and liability”, “Basic information on using the man-
ual”, "Other applicable standards/rules", “Person-
nel requirements”, “Remaining risks”.

Storage

If the product needs to be temporarily stored, it 
must be protected from dirt, the weather, and dam-
age. Each valve is tested with hydraulic oil in the 
factory, so that the internal components are pro-
tected from corrosion. However, this protection can 
only be guaranteed under the following conditions:

The product is delivered with adequate corrosion 

protection, provided our recommendations for the 
ambient conditions are followed.

 Storage outside or in maritime or tropical cli-
mates without appropriate packaging leads 
to corrosion and may make the product un-
usable.

 Make sure the product is stored so that no 
injuries can be caused by tipping or falling. In 
particular, make sure that the safety rules for 
high-bay racking are followed.

Commissioning

After installing our product in a system/machine, 
make sure that the requirements of the Machinery 
Directive are met if applicable. Access should be 
provided to the hydraulic diagram, the equipment 
list and the logic diagram for the system/machine.

 The product must be checked for damage 
and missing parts (e.g. seals) before instal-
lation, especially in the area of the sealing 
surfaces and the safety devices. If the safe-
ty devices or sealing surfaces are damaged 
or are missing individual parts with relevance 
to the product's function, the product may not 
be used. 

Remove all transport securing devices, protective 
covers and packaging.

 Check for foreign objects in the open hydrau-
lic passages. Contaminations may impair op-
erational reliability and shorten the service 
life.

 Make sure that the hydraulic system/machine 
is unpressurised before the product is in-
stalled.

 Before commissioning, the specialist person-
nel must verify that the entire hydraulic sys-
tem has been installed correctly. Commis-
sioning must be carried out with care, taking 
account of all safety regulations. 

If necessary, erect warning signs to prevent unin-
tended operation. Note also the information in sec-
tions “Warranty and liability”, “Basic information on 
using the manual”, "Other applicable standards/
rules", “Personnel requirements”, “Remaining risks”.

Compare valve type (located on the name plate) 
with part list resp. circuit diagram. 
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• The valve may be mounted fix or movable in 
any direction.

• Verify the mounting surface for the valve. Un-
evenness of 0.01 mm /100 mm, surface finish of  
6.3 µm are tolerable values.

 Keep clean valve mounting surface and work 
environment! 

• Remove protection plate from the valve mount-
ing surface

• Check the proper position of the valve ports 
and the O-rings.

• Mounting bolts:  
D1FB: 4 pcs. M5x30  
D3FB: 4 pcs. M6x40 
D31FB: 4 pcs. M6x40 
D41FB: 2 pcs. M6x55 / 4 pcs. M10x60  
D91FB: 6 pcs. M12x75 
D111FB: 6 pcs. M20x90  
Use property class 12.9, ISO 4762

Tighten the bolts crisscross with the following 
torque values: 

 Insufficient condition of the valve mounting 
surface might create malfunction! Incorrect 
mounting resp. bolt torque may result in abrupt 
leakage of hydraulic fluid on the valve ports.

Pressure fluids

The following rules apply for the operation with var-
ious pressure fluids: The above information serves 
for orientation and does not substitute user tests 
among the particular operating conditions. Partic-
ularly no liability for media compatibility may be 
derived out of it.

Mineral oil: usable without restrictions

For operation with the following pressure fluids 
please consult Parker:

For detailed information concerning pressure flu-
ids note VDMA-document 24317 as well as DIN 
51524 & 51502. 

Special gaskets may be available depending on 
the utilized fluid. In case of insecurity please con-
sult Parker.

Electrical connection

The electrical connection of the valve takes place 
by one common cable, which is coupled to the in-
tegrated electronic driver by a central connector 
assembly.   

The connection Codes F0, G0, M0, S0 requires a 
6 + PE female connector EN 175201-804.

HFA Oil-in-water emulsion

HFB Water-in-oil emulsion

HFC Aqueous solution (glycols)

HFD Unhydrous fluids (Phosphor-Ester)

The female connector has to be ordered sep-
arately under article nr. 5004072.   
 
A female connector with metal housing is re-
quired! Plastic made models may create func-
tion problems due to insufficient EMC-char-
acteristics.   

The connecting cable has to comply to the follow-
ing specification:

Cable type control cable, flexible, 7 conduc- 
 tors, overall braid shield 
Cross section min. AWG16/1.0 mm2

Outer dimension 8...12 mm
Cable length max. 50 m

 For cable lengths > 50 m consult Parker.  
 

The connection cable is coupled to the female con-
nector by solder joints.
Skinning lengths for the connecting cable:

Do not disconnect cable socket under ten-
sion!

D1FB:  7.6 Nm D31FB:  13.2 Nm
D3FB:  13.2 Nm D41FB:  13.2/63 Nm

D91FB:  108 Nm
D111FB: 517 Nm
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The backshell nut of the cable gland has to be tight-
en with a suitable tool. The target value for the tight-
ening torque is 4 Nm. Tighten the cap nut with a 
torque of approx. 5 Nm after attaching the female 
connector on the socket outlet.  

 Incomplete tightening of backshell nut resp. 
cap nut may result in automatic release of the 
connection as well as degradation of the wa-
ter tightness.

 Follow the “instructions for use“ for installa-
tion of female connectors made by other kind 
of brands!    

The cable connection to the female connec-
tor has to take place by qualified personnel! 
A short between individual conductors resp. 
to the connector housing , bad soldering as 
well as improper shield connection may re-
sult in malfunction and breakdown of the 
valve. 

The mounting surface of the valve has to be 
carefully tied to the earth grounded machine 
frame. The earth ground wire from the valve 
connecting cable as well as the cable shield 
have to be tied to the protective earth termi-
nal within the control unit. It is necessary to 
use a low ohmic potential connection between 
control unit and machine frame to prevent 
earth loops (cross section AWG6 > 10 mm²).

The shielding has to be assembled according the 
outline below:

The connection Code W5 requires a 11 + PE fe-
male connector EN 175201-804.

The female connector has to be ordered sep-
arately under article nr. 5004711.  
A female connector with metal housing is re-
quired! Plastic made models may create func-
tion problems due to insufficient EMC-char-
acteristics.    

The connecting cable has to comply to the follow-
ing specification:

Cable type control cable, flexible, 
  11 conductors, overall braid  
  shield   
Cross section min. AWG16/1.0 mm²
Outer dimension 12...15 mm
Cable length max. 50 m

For cable lengths > 50 m consult Parker.

The connection cable is coupled to the female con-
nector by crimp contacts.

Skinning lengths for the connecting cable:

For the workmanlike termination of the crimp 
contacts the tool # 932 507-001 – supplier: 
Hirschmann – is required. 

Do not disconnect cable socket under ten-
sion!
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Wiring diagram of supply voltage
Code F0/M0/S0/G0 (6 + PE)

Code W5 (11 + PE)

Electrical interfacing

Supply voltage:  

The supply voltage for the valve has to cover the 
range of 18...30 V. The residual ripple may not ex-
ceed 5 % eff.
  

The applied power supply must comply to the 
relevant regulations (DIN EN 61558) and must 
carry a CE-mark. The operating voltage for 
the valve must be free of inductive surges. 
Do not exceed the max. value of 30 V Non-
observance of this rule may result in perma-
nent damaging of the valve.

The increased inrush current of the valve 
should be considered when selecting the pow-
er supply. A stabilized power supply with over-
current limiting feature should not be used. 
Due to the inrush current of the valve the cur-
rent limit circuit may respond prematurely and 
create problems during energizing of the sup-
ply voltage.

The operation of the valve is blocked if the 
supply voltage polarity is interchanged.

Each valve requires a separate pre-fuse (rat-
ing: s. techn. data). Non-observance of this 
instruction may create irreparable damage of 
valve resp. incorporated system parts.
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 Incorrect signal amplitude levels may disturb 
the functionality and can damage the valve.

 The option 4...20 mA uses the “0 mA“ condi-
tion as breakdown-information. This means 
the presence of an evaluable failure informa-
tion if the input signal line is interrupted. In 
this case the actuator drive will be switched 
off. The drive will switch on when the input si-
gnal reaches a value of 3.8 mA, it switches 
off when the command falls below 3.6 mA. 
This determination follows the NAMUR-spe-
cification NE43.

 NAMUR is an association of users of process 
control technology.

Command signal input:
The command signal for the valve will be connect-
ed to the difference signal input of the electronic 
driver. The solenoid current behaves proportional to 
the command signal amplitude. Different versions of 
command signal processing are available, depend-
ing on the valve type. These are described below:
For the function description is assumed as signal 
reference (0V):
Code F0/M0/S0/G0: pin E, Code W5: pin 5

 Details are shown from the technical specifi-
cations.

 
 The command input signal needs to be filte-

red as well as free of inductive surges and 
modulations. Due to the sensitivity of the val-
ve a high signal quality is recommended, this 
will prevent malfunction.

Wiring diagram of voltage command input +10...0...-10 V Code F0/M0 (6 + PE)
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valve

command signal

0...+10 V
U 4-5

0 V
U 4-5

0...-10 V
U 4-5

potentiometer
command signal

control system

Uc

-Up

+Up

-10 V+10 V
5...10 k

4 5

2
10

9

function

D*FB

D*1FB

function

Wiring diagram of voltage command input +10...0...-10 V
Code W5 (11 + PE)

Wiring diagram of voltage command input +10...0...-10 V via potentiometer
Code W5 (11 + PE)

B

C
D

E

F B

C

A

valve

potentiometer
command signal

control system

Uc

-Up

+Up

-10 V+10 V
5...10 k

Wiring diagram of voltage command input +10...0...-10 V via potentiometer Code F0/M0 (6 + PE)

 The external potentiometer is fed 
via the output “potentiometer sup-
ply”. To prevent this output from 
overload, the resistance value of 
the potentiometer should be within 
a range of  5...10 kOhm. A nomi-
nal power rating of 0.1 W is suffi-
cient.
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Wiring diagram of current command input +20...0...-20 mA Code G0 (6+PE)

Wiring diagram of current command input 4...12...20 mA
Code S0 (6 + PE)

Wiring diagram of current command input 4...12...20 mA
Code W5 (11 + PE)
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Recall channels for internal command preset

Up to six corresponding inputs are provided for 
channel recall of internal command presets. The 
conjunction     

options of the internal command channels may be 
selectable via the parameter E21. The following op-
tions are      

provided:     

• priority dependent  

• additive    
 

At priority dependent channel recall the channel 
with the lowest numerical designation has priority 
against other      

simultaneously adressed preset channels.  
   

Example: Channels S1, S2, S3 are adressed.
Channel S1 has priority, the corre-
sponding internal command will be 
assessed as input signal. 
 

The preset channels have priority against the an-
alog signal input for the external command.   
  

At additive channel recall the internal signal presets 
of the recall channels as well as a possible signal 
at the external signal input will be added. The sum 
of the signal values is limited at 100%.

Example 1: Channel S1 = +50%, channel S2 = +20%, 
external input signal = +5V (= +50%). The 
sum is +120%, in this case +100% input 
signal will be assessed.

    
Example 2: Channel S1 = +50%, channel S2 = +20%, 

external input signal = -5V (= -50%). The 
sum is +20%, in this case +20% input 
signal will be assessed.   
 

The preset channels are switched through during 
the signal trigger at the dedicated inputs.
    
 More details are shown from the technical 

data.    
     
 The channel recall signals needs to be filte-

red as well as free of inductive surges and 
modulations. To prevent malfunctions a high 
signal quality is recommended.

Wiring diagram of recall channels

Code W5 (11 + PE)
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ProPXD screenshot

Parametering interface

ProPxD parametrizing software

The ProPxD software allows quick and easy setting 
of the digital valve electronics. Individual parame-
ters as well as complete settings can be viewed, 
changed and saved via the comfortable user inter-
face. Parameter sets saved in the non-volatile mem-
ory can be loaded to other valves of the same type 
or printed out for documentation purposes.

See www.parker.com/isde section “Support” or di-
rectly at www.parker.com/propxd for free software 
download.

Hardware requirements

• PC with operating system from Windows® XP 
upwards

• Interface RS232C

• display resolution min. 800 x 600

• connection cable between PC and electron-
ic module

• storage requirement approx. 40 MB

 If your PC has no serial interface according 
to RS232 standard, you require in addition 
an USB-RS232 adapter for connection to the 
USB interface.

Cable specification

The cable which is required for the connection of 
the valve electronic to a PC may be ordered un-
der code 40982923. The cable has to be inserted 
between an unused serial port of the PC and the 
5pole socket connector of the valve electronic (pa-
rametrizing connector).

Attention! The valve electronic provides no 
USB interface, but can only be parametrized 
via an RS232 - connection. Therefore the us-
age of USB standard cables is permitted and 
may result in damaging of valve resp. PC. 

The cover plug has to be re-installed after 
completion of the parametrizing work.

Parametrizing cable 
Ordering code: 40982923
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Program installation 

Please check before installation if the above hard-
ware requirements are met. If your PC has already 
stored an older version of the “ProPxD” program, it 
has to be deinstalled by using the Windows® sys-
tem control feature.

Program installation sequence:

• terminate the execution of other programs

• execute the file “setup.exe”

• follow the instructions on the screen

Answer the question, if an older version should be 
overwritten, with “ok”. During the installation you may 
change destination drive resp. installation path, if 
needed. Please answer “ok” if at the end of the in-
stallation the program reports any system informa-
tion. After successful installation the desktop display 
shows the ProPxD icon for starting the program.

Software operating

Brief instruction for first startup:

• Connect the valve electronic to the supply voltage.

• Connect the valve electronic to a PC via the pa-
rametrizing cable.

• Start the operating program.

• After displaying the program resp. data base ver-
sion a program window opens and the connect-
ed valve will be automatically identified (possibly 
a manual identification via the button “Receive 
all” is necessary).

• Select the desired version via the menu “Op-
tions/Optionen” with the menu item “Language/
Sprache”. 

• The valve specific default parameters are already 
available within the parameter table.

• Individual parameters may be selected via 
mouse or the arrow buttons at the center of the 
program screen.

• Parameter changes are possible via mouse or 
the arrow buttons on the bottom left within the 
program screen, also the parameter values may 
be edited via the keyboard.

• Modified parameters will be stored via the “En-
ter” key or via the button “Update list”.

• Parameters have to be nonvolatile stored on the 
valve via the button "save parameter".

• The chosen parameters may be optionally stored 
on the PC via the “File”-menu with the menu 
item “Save as”, data retrieving is always possi-
ble via the function “Load file”

Extended functions

The user software is shared into 2 parameter ranges:

• basic mode

• expert mode

For normal startup the basic mode is absolutely suf-
ficient. It permits the setting of all application spe-
cific parameters to match the valve function with 
the task setting. In case of special applications the 
valve parameters may be adapted via the expert 
mode. The operating mode may be selected from 
the “Options”- menu and remains after terminating 
and re-start of the program.

Changing of expert parameters is only per-
mitted for qualified personnel. Incorrect set-
tings may lead to malfunction! In case of pa-
rameter changes shut the drive down!

The expert mode is protected by a pass word re-
quest. The name is “parker”. The button “Send param-
eter” appears in the “Expert”-operating mode. This 
button transmits only the setting of one single pa-
rameter to the connected valve. Thus a quick tuning 
of single parameters is permitted during the setup.

A horizontal bar graph readout between the 
communication buttons shows the data trans-
fer state. 

Because the ProPxD program has also offline 
(i.e. without connection to the valve) function-
ality, a manual pre-selection of the parame-
ters is possible. After selection of the valve 
type via the menu “Options” the parameters 
may be set and stored for later transmission. 
Note the design series while selection of the 
valve!

The “File” menu provides the functions “Printer set-
up”, “Print preview” and “Print”. The print preview 
includes the option for parameter set storage as 
text file (format.txt) prior to further processing. The 
“Options” menu provides also the selection of the 
RS232C interface port via the menu item “Port”. Via 
the menu item “Load file” previously stored param-
eter sets may be loaded.
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Parameter overview for basic mode

Parameter Description Unit
Parameter Range Default 

Setting
Comment

from up to

S1 internal Sollwert S1 % -100 100 0.0

code W5 only
S2 internal Sollwert S2 % -100 100 0.0
S3 internal Sollwert S3 % -100 100 0.0
S4 internal Sollwert S4 % -100 100 0.0
S5 ramp accel. channel A ms 0 32500 0
S6 ramp decel. channel A ms 0 32500 0
S7 ramp accel. channel B ms 0 32500 0
S8 ramp decel. channel B ms 0 32500 0
P3 MAX channel A % 50.0 100.0 100.0
P4 MAX channel B % 50.0 100.0 100.0
P7 MIN channel A % 0.0 50.0 0.0
P8 MIN channel B % 0.0 50.0 0.0
P11 polarity command – 0 1 0

E17 option command –
1 = ±10V 

1 =  ±10V code W5 only
3 = 4-20mA

E19
cable break detection 

command
– 0

0 = ±10V
0 = +/-10V

codes S0 & W5 
only1 = 4-20mA

E25 MIN operating threshold –
0 = 1%

0 = 1%
1 = 0.01%

Adjustment parameters 

The available parameters may be divided into 
multiple groups and are characterized by different 
letters: 
S-parameters
P-parameters
E-parameters
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Individual Description of Basic Parameters

S1
command signal S1

Adjustment of the internal command signal channel S1.
To attenuate of an external accessible command signal.

S2
command signal S2

Adjustment of the internal command signal channel S2.
To attenuate of an external accessible command signal.

S3
command signal S3

Adjustment of the internal command signal channel S3.
To attenuate of an external accessible command signal.

S4
command signal S4

Adjustment of the internal command signal channel S4.
To attenuate of an external accessible command signal.

S5
ramp accel. channel A

Adjustment of ramp rate for increasing of the positive signal polarity.
To avoid switching noise.

S6
ramp decel. channel A

Adjustment of ramp rate for decreasing of the positive signal polarity.
To avoid switching noise.

S7
ramp accel. channel B

Adjustment of ramp rate for increasing of the negative signal polarity.
To avoid switching noise.

S8
ramp decel. channel B

Adjustment of ramp rate for decreasing of the negative signal polarity.
To avoid switching noise.

P3
MAX +

Adjustment of maximum signal span for positive output signal.
To match the command signal span to the valve operating range.

P4
MAX -

Adjustment of maximum signal span for negative output signal.
To match the command signal span to the valve operating range.

P7
MIN +

Adjustment for positive output signal step at 0,1% command signal.
To compensate for the overlap of the valve spool.

P8
MIN -

Adjustment for negative output signal step at 0,1% command signal.
To compensate for the overlap of the valve spool.

P11
command signal polarity

Adjustment of the command signal polarity.
To match the command signal polarity to the valve operating direction.

E17
type of command signal 
device

Adjustment of the command signal option.
To match the command signal input to the input signal mode.

E19
cable break detection 
command

Adjustment of the operating mode for the command cable break 
detection. To turn on resp. off of the cable break detection of the 
command signal at a selected command signal option of 4...20 mA.

E25
MIN operating threshold

Adjustment of the MIN operating threshold.
To match the response sensitivity for the MIN-stroke step.
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Parameter overview for expert mode

Para-
meter

Description Unit
Parameter Range

Default Setting Comment
from up to

S11 ramp for int. command S1 ms 0 32500 0

code W5 
only

S12 ramp for int. command S2 ms 0 32500 0
S13 ramp for int. command S3 ms 0 32500 0
S14 ramp for int. command S4 ms 0 32500 0
S17 default ramp ms 0 32500 0
P5 dither amplitude % 0 10.0 0
P6 dither frequency Hz 0 300 0

E21
option internal command

signal conjunction
–

0 = priority dependent 0 = priority 
dependent

code W5 
only

1 = additive

E22
int. command signal 

ramp function
–

0 = quadrant dependent 
(S5...8) 0 = quadrant 

dependent1 = int. command depend. 
(S11...14)

E83
int. command signal 

functionality
–

0 = standard
0 = standard

1 = special option DFL

Individual Description of Expert Parameters

S11
ramp for internal 
command signal 1

Adjustment of the ramp rate for the internal command signal channel S1. 
To avoid switching noise.

S12
ramp for internal 
command signal 2

Adjustment of the ramp rate for the internal command signal channel S2.
To avoid switching noise.

S13
ramp for internal 
command signal 3

Adjustment of the ramp rate for the internal command signal channel S3.
To avoid switching noise.

S14
ramp for internal 
command signal 4

Adjustment of the ramp rate for the internal command signal channel S4.
To avoid switching noise.

S17
default ramp

Adjustment of the ramp rate for the default ramp.
To avoid switching noise.

P5
dither amplitude

Adjustment of dither amplitude.
To reduce the influence of solenoid friction.

P6
dither frequency

Adjustment of dither frequency.
To match the dither signal to the valve dynamic.

E21
internal command signal 
conjunction

Adjustment of the conjunction for the internal command signals.
To match the command signal logic.

E22
internal command signal 
ramp function

Adjustment of the ramp function for the internal command signals.
To match the ramp functionality.

E83
internal command signal 
functionality

Adjustment of the functionality for the internal command signals.
To match for the special option DFL.
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Failure message Description/corrective action
The Com Port is not available! Terminate the other program, or quit the message and select an-

other RS-232 port via the menu “Options > Port”. Afterwards recon-
nect the parametrizing cable.

Unable to open COM port Com port is not available. Quit the message and select another 
RS-232 port via the menu “Options > Port”. Afterwards reconnect 
the parametrizing cable.

There is no module/valve con-
nected or the communication 
is disturbed! Please check 
also the interface!

No data exchange possible. Either the electronic has been re-
moved, the port is mismatched, or the connection will be disturbed 
by strong electrical fields. Check if the Com port is set for “9600, 8, 
1. none, none” via the menu “Options > Port”.

Wrong password Retype the password, notice the exact spelling (case sensitivity).

Wrong input An unvalid character or a value outside the permitted range has 
been used at parameter entry.

Keep the entered para-
meters?

During parameter loading from the electronics memory the preset 
parameters from the left hand screen display may be rejected or 
maintained.

The chosen module/valve 
isn´t the same as the con-
nected hardware. Attention! 
Unsaved parameters will be 
lost.

In principle, parameters dedicated to a type which deviates from 
the connected valve may be edited. However, for data transmitting 
the correct valve has to be connected. If parameters will be loaded 
from a valve which deviates from the selected one, the param-
eters from the left hand side screen display of the program will be 
overwritten.

The chosen hardware isn´t 
the same as the connected 
module/valve.

The wrong valve type has been selected from the database, after-
wards the function “send all” has been executed.

Attention! Factory settings 
will be changed! Transmit 
anyhow?

Default parameters has been read out from the database instead 
from the valve via the function “receive all”.

file name.pxd already exists. 
Do you want to replace the 
file?

The file name already exists within the indicated directory. Select 
another name, another directory or overwrite the existing file with 
“OK”.

Error messages

Malfunctions when using the ProPxD software 
program will be indicated via appropriate failure 
messages.

Failure messages and corrective actions:
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Operation

If any of the safety features of the product are 
not operational, the system/machine must be 
shut down immediately.

Do not carry out any activities that might jeop-
ardize safety. 

Note also the information in sections “Warranty and 
liability”, “Use of operating instructions)”, “Compli-
ance with other rules and instructions”, “Personnel 
requirements”, “Remaining risks”. 

Modification

We define modification as the replacement of a de-
fective valve with a new valve of the same series. 
In particular, it is not permitted to open the valve. 

Make sure that the hydraulic system/machine 
is unpressurised before the product is in-
stalled/removed. 

Service/maintenance

Service work may only be carried out by qual-
ified personnel. Detailed knowledge of the 
machine functions concerning switching on 
and off as well as of the required safety rel-
evant technical tasks is required!

Periodical maintenance is essential for the longevity 
of the system and guarantees reliability and avail-
ability. The following properties of the system has 
to be checked in continuous short time intervals:

• oil level in the tank
• max. working temperature
• condition of the pressure fluid (visual inspec-

tion, color and smell of hydraulic fluid)
• working pressure levels
• gas pre-load pressure on the pressure accu-

mulator
• leakage on all system components
• condition of filter elements
• condition of hose lines
• cleanliness of components

After a certain operating duration a change of the 
hydraulic fluid is required. The frequency of change 
depends from the following circumstances:

• kind resp. grade of the pressure fluid
• filtering
• operating temperature and environmental con-

ditions

Air bleeding of hydraulic system 

During initial startup, after an oil change as well 
as after the opening of lines or valves the hydrau-
lic system must be air bleeded.

Filter

The function and lifetime of the valve are strongly 
affected by the cleanliness of the fluid.
Purity level class of 18/16/13 acc. ISO 4406 is re-
quired.
  
Flushing    

It is recommended to flush the pipelines by short 
circuiting the pressure and return lines. This pre-
vents the installation dirt from entering the valve.

Decommissioning

Make sure that the hydraulic system/machine is un-
pressurised before the product is removed. Note 
also the information in sections “Warranty and li-
ability”, “Use of operating instructions”, “Compli-
ance with other rules and instructions”, “Person-
nel requirements”, “Remaining risks”.

Disposal

At the end of the service life of this product

• all escaping pressure fluids must be removed 
and disposed of properly

• any significant fluids remaining in the prod-
uct must be removed and disposed of properly

• all materials must be segregated for recycling 
when they are removed and taken to a suitable 
recycling center.

Please segregate the packaging material proper-
ly (e.g. paper, plastic). None of the components of 
the product contain hazardous materials.

The normal local environmental protection 
laws must always be met when disposing the 
product.

Note also the information in sections “Warranty and 
liability”, “Basic information on using the manual”, 
"Other applicable standards/rules", “Personnel re-
quirements”, “Remaining risks”.
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malfunction at hydraulic load runtime
- generally no function

- high frequent oscillation
- low frequent oscillation

- one way operation only
- speed variations at unchanging command

- different speeds depending on travel direction
- speed too low

- drifting without command
possible reasons for malfunction corrective actions

x hydraulic pump resp. motor defective replace hydraulic pump resp. motor
x x x x x x drive overloaded reduce pressure resp. speed, increase valve size
x x x x x x x valve contaminated clean pressure fluid, filter / flush valve

x x hydraulic fluid too viscous / too cold change fluid grade, provide operational temperature
x x x too low oil level within tank refill pressure fluid

x x x filter contaminated clean resp. replace filter
x x x x supply voltage too low keep supply voltage range

x supply voltage carries too much ripple reduce ripple
x x x command signal too low increase command signal

x command signal carries too much ripple reduce ripple
x dither signal amplitude too high reduce parameter P5

x dither signal amplitude too low increase parameter P5
x x x x x central connector contact failure clean contacts resp. replace connector
x feed cable interrupted fix feed cable
x x x x x x x wiring sequence incorrect correct wiring sequence

x x feed cable without shielding change cable grade
x*) pilot flow configuration incorrect correct pilot flow configuration

*) only for D*1FB

Troubleshooting table

4. Product information

Other applicable standards / rules

• ISO 4406:1999-12 Hydraulic fluid power - Flu-
ids - Method for coding the level of contamina-
tion by solid particles

• ISO 4401:2005-07 Hydraulic valves; mounting 
surfaces and connecting plates

• DIN EN 60204-1; VDE 0113-1:2007-06 Safe-
ty of machinery – Electrical equipment of ma-
chines – Part 1: General requirements

• DIN EN 60529; VDE 0470-1:2000-09 Degrees 
of protection provided by enclosures (IP code)

• DIN EN 61000-4-2/3/4/6/8 Electromagnetic 
compatibility

• DIN 51524-1:2006-04 Pressure fluids - HLP 
hydraulic oils - Part 1: Minimum requirements

• DIN 51525-2:2006-04 Pressure fluids - HLP 
hydraulic oils - Part 2: Minimum requirements

• German Occupation Safety Ordinance (Be-
triebssicherheitsverordnung)

• German Labour Protection Act (Arbeitsschutz-
gesetz)

Trouble shooting

Basis of troubleshooting is always a systematic 
approach. At first the following questions have to 
be checked:

• Are there practical experiences with similar 
failures?

• Have system adjustments been changed?

Afterwards starting of troubleshooting by means of 
a priority list of the most likely reasons.

For suspect of a sluggish spool the valve may 
be flushed with clean pressure fluid.

Troubleshooting in a hydraulic system requires 
in either case a systematic approach. The 
work may exclusively be performed by qual-
ified personnel, as it requires detailed knowl-
edge about function and construction of the 
system. Reversals or disassemblies may not 
be taken imprudently! Prior to the works it 
has to be clarified, if the system has been op-
erated properly until the failure occured.
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Accessories / Spare Parts

Accessories

The following accessories are available for the 
valves series D*FB/D*1FB:

D1FB:
bolt kit ordering code BK375
Code F0/M0/S0/G0: 
female connector 6+PE ordering code 5004072
Code W5: 
female connector 11+PE ordering code 5004711

D3FB:
bolt kit ordering code BK385
Code F0/M0/S0/G0: 
female connector 6+PE ordering code 5004072
Code W5: 
female connector 11+PE ordering code 5004711

D31FB:
bolt kit ordering code BK385
Code F0/M0/S0/G0: 
female connector 6+PE  ordering code 5004072
Code W5:  
female connector 11+PE  ordering code 5004711

D41FB:
bolt kit ordering code BK320
Code F0/M0/S0/G0:  
female connector 6+PE  ordering code 5004072
Code W5:  
female connector 11+PE  ordering code 5004711

D91FB:
bolt kit ordering code BK360
Code F0/M0/S0/G0:  
female connector 6+PE  ordering code 5004072
Code W5:  
female connector 11+PE  ordering code 5004711

D111FB:
bolt kit ordering code BK386
Code F0/M0/S0/G0:  
female connector 6+PE  ordering code 5004072
Code W5:  
female connector 11+PE  ordering code 5004711

Spare Parts

The following spare parts are available: 

D1FB:
seal kit NBR ordering code  SK-D1FB

D3FB:

seal kit NBR ordering code  SK-D3FB

D31FB: 
seal kit NBR ordering code  SK-D31FB
 FPM  SK-D31FB-V

D41FB: 
seal kit NBR ordering code  SK-D41FB
 FPM  SK-D41FB-V

D91FB: 
seal kit NBR ordering code  SK-D91FB
 FPM  SK-D91FB-V

D111FB: 
seal kit NBR ordering code  SK-D111FB
 FPM  SK-D111FB-V

Hotline in Europe

Phone: 00800-2727-5374

Please direct technical product enquiries to:

Parker Hannifin 
Manufacturing Germany GmbH & Co. KG
Industrial Systems Division Europe
Gutenbergstr. 38
41564 Kaarst, Germany
Tel.: (+49) 181 99 44 43 0
E-mail: valvesisde@parker.com




